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Chapter One:Product description

The laser, called the stimulated radiation light amplification,Its high brightness, high
directivity and high monochromaticity,and high coherence, is unmatched by other light,
laser beam through the focus, the focus of thousands or even tens of thousands of
degrees high temperatures, make it possible processing almost all materials.Laser mark is
the use of high power density of the focused laser beam in different kinds of material
surface permanent mark in the moment

Laser processing compared with traditional mechanical process has the following
characteristics:

1) But for a variety of non-metallic materials processing, especially for high hardness,
high melting point, brittle materials.

2) Belong to non-contact processing, no damage to the product, no tool wear,
tags are of good quality.

3) After through focused laser beam, the focus can be small to a few microns
in diameter,so the processing materials consumption is very small, processing small
heat affected zone.

4) fast process speed,high efficiency.

5) Can be transferred by computer control, easy to realize automation, can mark
Numbers, characters, vector graphics and bitmap graphics, etc.

6) Processing the noise is small,no pollution to the environment .

7) Laser mark different from the traditional printing way, mark trace is not easy to
be erased,but forever.
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The main purpose and scope of application:

LX-30W laser marking machine is the collection laser,computer,automatic control, precisi
on machinery technology as one of the high-tech products. The marking machine adopts
the galvanometer scanning way, in a variety of non-metallic materials such as wood,org

anic board, rubber, ceramic, marble and other materials to compose the permanent mar
king difficult to imitation.

It has wide application : Hardware tool,IC,instrument and apparatus,electronics,machinery et
c .

Chapter Two: All the parts of equipment and operating instructions

30Watt fiber laser marking machine structure

Equipment composition

1：Cabinet body

4：Control panel

2：Keyboard tray

8：Two-dimensional stage

5：Lifting handle

6.Scanner head

3：Monitor

7.Rotary fixture
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1:Cabinet body

2. Keyboard tray
Put keyboard on it,the mouse can be placed on the cabinet table. Laptop can connect with

keyboard and mouse via USB cable.

3:Monitor

4：Control panel

5：Lifting handle
It is used to adjust the rise and fall of the machine , adjust the suitable focal length. Lift travel

is 45mm.

6：Scanner head

7：Rotary fixture
It work with marking machine when marking on cylinder material ( Optional)

8：Two-dimensional stage
Change the center position of material to scanner head , accurate positioning,the adjust range of up
and down around is 80*80mm

Machine cabinet composition and operating instructions

General power key switch

Laser power switch

Red light power switch
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Main power supply key switch (Machine power)：
Control machine’s electricity , switching on or off . Machine will completely disconnect from
power .
Laser power switch (Laser)
Control fiber laser source power

Red light power switch (Red light)
Power on if need positioning, turn off when not in use to increase life .

Machine power sequence
Turn on key power switch--Turn on the computer--Turn on laser power-- Turn on Red light power
if need --Open EzCad software .

Shutdown sequence
Finish EzCad software--Turn off Red light power--Turn off laser power--Turn off the
computer--Turn off key switch .

The internal construction of Control cabinet

Fiber laser source

Laser source power
Scanner head power

Pedal switch
interface

Optical fiber transmission line

Control card

Control card power

Rotary driver card

220V power entrance
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Fiber laser source
Laser source main component

Control card
Control laser and scanner head through computer

Fiber laser source power
Provide voltage and control signals to fiber laser source .

Scanner head power
Provide direct current supply to scanner head .

Control card power
Provide direct current supply to control card .

Fiber transmission cable
Note : The bending radius of Optical fiber transmission line can’t be too small,so as to avoid
damage .

Pedal switch interface
External pedal switch, control marking output

220V power entrance
Input AC 220V±10% 50/60Hz Voltage

Rotary fixture connect entrance
Note : The machine should be power off before
connecting or disconnecting the rotary fixture !
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Machine internal structure and function introduction of each parts

Machine frame constitute

1： Red light indicator
The red light with 650nm wavelength ,which can be seen,is used to indicate and
positioning .The visible light will pass though all frame internal optical element and reach
scanner head .

2： Red light installation base
It is used to fix and adjust the angle of red light .There is a red light reflector which installed
with 45 degree angle.It can get through 1064nm laser, reflect 650nm red light, then make the
red light coincide with laser .

3：Fiber output head
The fiber output head match with laser source,output laser beam with 8mm diameter directly
which is suitable for scanner head .

4：Fiber output head fixed base
Be used to fix fiber output head.After fixation ,the fiber laser beam will align with the light

hole positive center of the scanner head.

2:Red light installation seat

4: Fiber output head
fixed base 3：Fiber output head

1:Red light indicator

LX-30W Fiber Laser Marking Machine Operation manual EN 9



9

Chapter Three:Machine installation and adjustment

1：The installation of equipment parts

LX-30W laser marking machine installation is very simple, the equipment rear all adopt t
he standard connectors to connect, the connector specification is different, to avoid the
possibility of wrong. Equipment should be used in clean indoor, main body it doesn't m
atter to the wall, at least 0.5 m distance, the aim is to ensure that components of the
cooling equipment

2：The first electric test equipment

According to the boot sequence: open the key switch--open the computer--open the lase
r power switch--turn on red light switch (open when necessary)--open the Ezcad softwar
e

After open the software interface, enter a character or rectangular, put a metal namepl
ate or other materials , adjust well the correct focal length (the distance from the lowe
r edgeof the lens to the surface of a material of vibration), software to adjust good ma
rking speed and laser power, marking the output, then should laser materials appeared.

3：Equipment operation technology and skills
The effects of focus position
After focusing the laser beam as shown in the figure below, should mark parts
surface is located in the depth of focus range (about 1 mm ~ 2 mm).

The highest when the laser power density ,laser etching effect is best, we usually adjust
the lifting platform to observe the laser brightness and sound of the laser marking on

the materials to identify whether the work piece surface within the scope of the depth
of focus. Sometimes it can achieve special marking effect by positive defocus and negati
ve defocus.
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The influence of laser frequency and pulse width
In certain cases, the output power can be laser frequency and pulse width to improve
by reducing peak power, average power reduction). Laser peak power is high, easy to
form "sculpture" effect on the surface; Also, by increasing the frequency and pulse
width can reduce peak power (average power increase). Laser mean power is high,
easy to form the ablation effect on the work piece surface .The working frequency ran

ge of laser source is 20-80KHz .

The galvanometer scanning,and the effects of parameters on the software
software set parameters on the marking effect has great influence, parameter setting is
unreasonable, will appear at the end of the tag text pen or pen overweight or turn pe
n, pen overweight or leakage into arc, graphics, the phenomenon such as high speed fill
ing filling part beyond the border. Please see instruction software parameter adjustment

Chapter Four:Equipment maintenance and breakdown maintenance

1：Equipment maintenance and matters needing attention

Fiber laser marking machine has the feature of stable working, long lifespan . The cooling system
of laser source is air cooling . It is maintenance-free . Users should operate strictly according to
manual,maintain with right way to reduce the incidence of failure .

Equipment maintenance mainly has the following points:

1). Pay attention to the optical fiber transmission line at the back of the rack .Do not
bend with acute angle, or it will damage easily .
2).Equipment should be used in clean indoor air, best at room temperature in 22 to 25
degrees

3).Do not keep machine body close to the wall,at least 0.5 m distance, the aim is to e
nsure heat dissipation of machine.
4).There will be some dust When processing material , because material surface is vapor
ised by laser. And the dust will pollute the lens. Then users can put a small fan to avo
id the pollution of lens .
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5).It can be scrubbed gently by lens paper or ethanol if the lens is dirty. Please pay more
attention about the operating environment, avoid the scrub times of lens as possible .

6).Open the cover plate at machine’s left and right side regular. Clean up the air inlet, and open
the back cover plate of the machine regular .Clean up the fan of back plate to improve machine’s
cooling effect .

2:Breakdown maintenance processing

abnormal
phenomenon

Reason analysis Processing method

Machine can’t be
powered on (The
machine is not
power on after
opening the key
switch and level
switch)

1.Machine power cable poor
contact.
2.Blown fuse or the
emergency stop switch is in
the wrong state

1.Reconnect the power cable,check power
outlet .
2.Check blown and urgent stop switch
state

Frequent power ou
tages when equip
ment normal use

Power cable or outlet poor
contact.

Reconnect the power cable,check power
outlet

Without laser
output

1.Inappropriate parameter
setting
2：Machine is breakdown.

Check software parameter,and check if
laser source type is right or not .Or
re-install the software .

Laser energy is
weak

1.The lens is dirty
2.The focal length is wrong.

1.Wipe with cotton ball dipped in ethanol
2：Adjust the table height to the correct
focal length

Computer control
has but only one
laser point or only a
horizontal line or
vertical line only,
not form the text

The galvanometer is not
powered or damage

Check the 25 core socket back of scanner
head to see whether it is bad connect .And
re-connect again. To contact factory
after-sale if it still not work .

There is no red
light indicate.

1.The red light is old and
damage
2.The power supply of red
light is damage

1.Change red light head
2.Check red light head whether there is
5V dc voltage supply .

When operate the
software,there is
reminder that the
control card can not
be found or
software dog can’t
be found and

1.The USB cable of marking
software control card poor
contact .The driver of
marking software control
card is installed with wrong
way.
2.The USB software dog

1.Re-plug .
2.Re-install control card driver,check the
device manager and observe whether
there is marking card choice (LMC)
3.Change USB port,re-install software
dog driver program.
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software will
operate with demo
mode .

plugging at the back of
computer host is firmly
connected or the diver is
installed with wrong way .

Chapter Five:Technical parameters

Input power supply：

Input voltage：AC220V±20V

Frequency：50/60Hz

Power Input：0.5kVA

Laser output：

Wavelength：1064nm

Laser power：30W

Instability：＜±2％

Laser frequency：20-80KHz

Pulse width：70-90ns

Single pulse energy：0.5mJ

Marking area ：110mmx110mm （Optional ）

Scanning speed：（0～7000）mm/s

Marking line depth：（0.01～0.6）mm （Subjected to material）

Marking line width：（0.01-0.1） mm （Subjected to material）

Mechanical structure ：

XY table travel： 80mmx80mm

Lifting height of lifting platform ： 450mm

Cooling ：

Cooling system：Air cooling

Continuous working hours ：≥12h .

Considerations when installing :
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Whole machine picture

Install the panel on the lifting platform to place the rack
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Computer installation on the machine cabinet
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Lifting platform install on equipment cabinet

Take off the cover of lens before using

Note : Uninstall the two-dimensional stage as below picture
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before installing 300*300mm lens (other marking area lens is no
need to uninstall)
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1. Introduction
1.1. SeaCAD5.0 Brief Introduction

1.1.1. Software Brief Introduction

The SeaCAD5.0 software supports Unicode and can run in several operating

systems of the Microsoft Windows series, including Windows XP, Windows VISTA,

Windows 2003 and Windows 7. All the following descriptions in this manual are

applicable to the currently predominant Microsoft Windows 7 operating system by default.

SeaCAD 5.0 software is an upgraded version of SeaCAD 3.0, which expands the

support for multi-document marking, and multi-type lasers; it also provides version

compatibility support for the storage of graphic files, now Graphics files of 5.0 and above

can be read and written by any version of the above 5.0 program.

SeaCAD5.0 is installed in a green way: extract the installation package into any
directory in the hard disk, and then double click the SeaCAD.exe under the directory to
run the software. .See the following figure.

Fig.1-1 Software Initial

SeaCAD5.0 has no any special requirement on the computer hardware and the
computer system able to run the operating system smoothly will provide the computer
hardware environment required by this software.

1.1.2. Software Function

Main functions of this software:

● User can Design their graphics freely .

● Supports multiple document editing, multiple documents, multiple cards, and multiple
laser types marking simultaneously.

 Supporting all the fiber lasers, CO2 lasers and end-pumped lasers in the market. The
parameters, such as the electric current, impulse frequency and duty ratio, can be set
and adjusted through the software according to different laser types.
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 Supporting the single red light marking pointer.

 Providing the software access control to prevent the parameters from being modified
at random.

 Providing powerful IO control function: enabling your machine to easily realize
automatic control through the port control.

 Provides manual correction, equal proportion correction, and fitting correction
methods to obtain extremely accurate marking results.

 Providing the expansion axis function: supporting the expansion axis to rotate
according to the angle, such as rotary marking and bi-axial figure marking.

 Supporting the mark on the fly: suitable for the continuous marking.

 Supporting the rotary marking: setting the rotation angle of the rotary axis between
the marking operations, and suitable for the marking on the cylindrical work piece
surface.

 Supporting the hatching operation: providing rectilinear hatch and round hatch at any
angle and in a crossed manner, with the adjustable margin, border, space, etc.;
supporting the hatching combination of three layers at most, with parameters of each
layer set independently.

 Providing the variable text function: fixed text, serial number, data code, time, TCP/IP
communication, serial communication, SQL database, etc.

 Supporting the image marking.

 Supporting 256-layer marking parameters: supporting the parameters of each layer
to be set randomly to easily realize multi-parameter marking.

 Supporting image files such as PLT, DXF, BMP, JPG and JPEG.

 Supporting the common 1D/2D barcodes, such as Code39, EAN, PDF417 and
DATAMATRIX.

 Providing the text input function and supporting various types of fonts, such as True
Type, Jsf, barcode font and fonts added by the user (such as Dot Matrix Font).

 Supporting the dynamic file marking. When the text and graphs are marked, the
filename is fixed, but the file content will be changed.

 Providing powerful editing function: supporting the arc arrangement of characters,
random graph drawing/editing, uncombining/combining, grouping/ungrouping,
undoing/redoing, plastic, etc.

 Providing the simulation function: the graph marking tracks can be previewed before
marking operation.

 Supporting secondary development: providing the SDK secondary development
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library, supporting the user to customize the development, expanding the functions of the
existing marking system and meeting the user’s requirements in special applications.

1.1.3. Interface Introduction

 Starting initial interface

The interface (Fig. 1-2) appears when the program runs, and meanwhile the initial
operations take place in the background.

Fig.1-2 Program Starting Interface

 Main interface
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Fig.1-3 Main Program Interface

1.2. About SeaCAD3.0 User’s Manual

1.2.1. Contents Arrangement

This manual will introduce the usage of SeaCAD5.0 according to the order of the
menu bar in the main interface, including five main menus: File, Edit, Draw, Modify and
View,Speical,Maeking,Laser,Scanhead Calibration,Help。

1.2.2. Announcement

● Other products and company names involved in this manual may be the trademark
of the corresponding owner.

● Other product and company names mentioned herein may be the trademarks of
their respective owners.

1.3. Instructions of Software Installation

This software is green software and can run immediately after extracted.

When the software starts and the reminder of “xxxx.dlll cannot be found” appears, carry
out vcredist_x86_2010.exe to install the system patch.
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2. File Menu

The File Menu is used for common file operations, such as “New”, “Open” and “Save”, as
well as functions like system parameter setting and common graph library maintenance.
See Fig. 2-1.

Fig. 2-1 “File” Menu

2.1.New(N)

“New” is used for creating a blank workspace to construct objects, and its shortcut
key is “Ctrl+ N”.

The icon of “New” in the Toolbar is . Clicking on this icon will achieve the same
operation.

If you move the mouse cursor onto the icon mentioned above and keep it for a while, a
piece of prompt information (Tool-tip) will appear, which briefly explains the function of
this icon, and there will also be some detailed explanations appearing in the Status Bar in
the bottom of the main window. And if you move the mouse cursor onto “New” in File
Menu, only the detailed explanations will show in the Status Barr, but the prompt
information will not.

[Reminder: in the SeaCAD3.0 software, each icon in the Toolbar has a function of
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showing brief prompt information and the Status Bar has a function of displaying detailed
explanations. Also, each icon has a corresponding menu item, and both the two ways
carry out the same function. The User’s Manual will not mention it again in the following
chapters.]

2.2.Open(O)

“Open” is used for loading a saved “..orz” file, and its shortcut key is “Ctrl + O”. When you
click “Open”, the software will pop an open-file dialog box (Fig. 2-2) to ask you select the
file you want to open. See fig 2-2.

Fig. 2-2 “Open” Dialog Box

The icon of “Open” in the Toolbar is .
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2.3.Save(S)Save As(A)

“Save” is used for saving the current state of a mark Document to disk. “Save As” is

used for writing the current mark Document to disk by another name. The file can be

saved in either of these two ways.

If the current Document has already been named, “Save” is selected to save it under

the name that was used for opening the file, or the software will prompt the user to

choose a destination path and type a name. Whether the current file is named or not, the

“Save As” dialog box (Fig. 2-3) will appear to ask for a new name to save the file, and the

previous file will not be overwritten.

Fig. 2-3 “Save As” Dialog Box

The icon of “Save” in the Toolbar is 。

2.4.Print

Print is used to print current image and its shortcut key is “Ctrl+ N”.

2.5.Scan Image(m)

‘Obtain Scan Image’ is used to get images from specific external devices. Selecting this

command will bring up the dialog box shown in Figure 2-4. Requires the selection of an
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external device (the listed devices are legitimate drivers already installed on your

computer). When an external device is selected, the corresponding device image

processing dialog box appears. You can select the corresponding image input. (The

dialog box varies depending on the device. Please refer to the corresponding device

operating instructions.)

Fig.2-4 Scan Image

2.6.System Parameter(P)

“System Parameter” configures the software. When it is selected, a dialog box as

shown in Fig. 2-4 will appear, and you can set the unit the software uses, the color

displayed, the work space’s parameter, user manager and other parameters.
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Fig. 2-5 “System Parameter” Window

The icon of “System Parameter” in the Toolbar is .

2.6.1.General

In “General”, common parameters can be configured.

“Paste X” and “Paste Y”: refer to the new object’s offsets with respect to previous one

(pasted object) when the Copy/Paste function is used, as shown in Fig. 2-6:

Software User manual EN 33



Fig. 2-6 Original Graph and Copied and Pasted Graph

“Smoothing Parameter”: controls the smoothness of the vector diagram generated by

the software.

“Grid”: shows or hides the grid.

“Grid Space”: adjusts the distance in grid.

“Execute when SeaCAD Starts”/“Execute when SeaCAD Finish”: start the

executable programs provided by the third party to realize some relevant operations.

Open a new file when SeaCAD Starts ：a new file named "SeaCAD1" is automatically

created after the software is opened.

“Input IO Mask”: sets the input port supported by the current software.

“Output IO Mask”: sets the output port supported by the current software.

2.6.2.Color

“Color” is used for setting the color of background, workspace, guide line and grid, etc.

Double clicking the color stripe could change the corresponding color. See Fig. 2-7.
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Fig. 2-7 Color Setting

2.6.3.Workspace

“Workspace” is used for setting various parameters in the operating area, enabling the

user to customize them based on his habits. See Fig. 2-8.
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Fig. 2-8 Workspace Setting

2.6.4.Auto Save

“Auto Save” is used for setting the interval time between two automatic saves, so as to

efficiently prevent missing file in case of any emergency (such as power failure or dead

halt). According to the set interval time, the current data is saved in the file named

“autosave.orz’ in SeaCad’s directory. See Fig. 2-9.
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Fig. 2-8 Auto Save Setting

2.6.5.Move-Rotate

Nudge Distance： refers to the distance that the selected object moves each time

when the direction key is pressed, if the direction keys of the keyboard are used for

moving the graphs.

Big Nudge Scale: If the distance to be adjusted is long, synchronously pressing

direction keys and “shift” key will enable the selected object to move for a distance of

Nudge Distance*Big Nudge Scale.

Rotate Angle: refers to the angle the object rotates each time when direction keys and

“ctrl” key are pressed together.
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Object’s Origin: determines which point of the object should be put on the origin when

the “Put to Origin” function is used. SeaCAD 3.0 divides each graph into 9 position points

(0-8). “Object’s Origin” can be set by positioning the graph accurately at the user’s will.

Fig. 2-9 shows the origin setting based on Position 1. After the graph is drawn in the

workspace of the software, click (Put to center) button:

Fig. 2-9 Example of “Put to Origin”

2.6.6 User Manager

It is used for setting whether the user password shall be input to use the current software,
as shown in Fig. 2-11.

When “Enter the Password before Using” is selected, the system is configured with only
one administrator and one designer by default, but the user can add operators.

The administrator can use all functions of the software.

The designer can use all functions of the software, excluding modifying the user
information and system parameters.

The Draftsman can draw files, set marking parameters, but cannot set the user
information, system parameters and marking files.

The operator only can open the completed document to perform marking, but cannot
modify or save the document, or modify the system parameter, which can prevent the
operator from changing the system parameters by mistake to cause abnormal work of the
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equipment.

Fig. 2-10 User Manager

 Infrequent use parameter editing enable：When this item is not checked, the infrequently

used parameter items in the main interface-Marking parameter -advanced options are

grayed out and cannot be edited, as shown in Figure 2-12. Check this item r to enable

editing.
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Fig.2-11 Advanced options

2.6.7. Language

It shows the language package installed in your computer. You can use it to change the

language used in the interface of SeaCAD. The change will not take effect until the

software is restarted next time.

Software User manual EN 40



2.7.Common Graph Library

This function can import the graphs frequently used to the common graph library for use

at any moment. The specific procedures are as follows:

1. Save the graph library file

Draw or import the graph which you want to save in the common graph library in the

workspace, select that graph, open the “File”/“Common Graph Library” dialog box, then

click “New Graph Library” to enter the name of the new graph library in the “New Graph

Library” dialog box, and click “OK”.

Fig.2-12 Images Library

When the graph library is created, add the graph to be saved. Select the graph in the

workspace, click “Add Graph” to enter the graph name, and click “OK” to save the graph

selected in the work pace in the “Common Graph Library”.

2. Copy the graph from the graph library
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If the graph in the graph library is to be copied, open the common graph library and drag

the graph to be used to the workspace by pressing the left mouse button.

Fig.2-13 Copy the graph from the graph library

2.8.Recent File List

Below “System Parameter”, a list is displayed to show the files recently opened by the

user. If the user has never opened/saved any “.orz” file, such a list will not appear.

2.9.Exit (X)

It is used for exiting the SeaCAD software. If any file is not saved, the system will ask you

whether to save it.
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2.10.Object List

Object List is in the left side of the main interface of SeaCAD, as shown in Fig. 2-15.

Fig. 2-15

Object List

Note: during marking, the system will follow the order in the object list (from top to bottom)
to mark the listed objects.

The user can rearrange the list by directly dragging the object or through the right key.

The user can double click the object name to rename it.

2.11.Object Properties Toolbar

Object Properties Toolbar is displayed in the left side of the main interface of the software,
as shown in Fig. 2-16.
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Fig. 2-16 Object Properties Toolbar

X Position: the X coordinate of the selected object. It can indicate the coordinate of the

object’s left bottom corner or its center. The coordinate data button is used for

setting the specific content of the coordinate.

Y Position: the Y coordinate of the selected object. It can indicate the coordinate of the

object’s left bottom corner or its center. The coordinate data button is used for

setting the specific data of the coordinate.

Z Position: the Z coordinate of the selected object.

X Size: the width of the selected object.

Y Size: the height of the selected object.

: locks the current length/width ratio of the selected object. If the user changes X and

Y Sizes, the system will keep the length/width ratio of the new size unchanged.
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Coordinate Data Button : determines whether X position and Y position
correspond to the coordinates of the left bottom corner or center of the object or other

given positions. When the user clicks this button, a dialog box will appear to ask the user

to select the position corresponding to the coordinate. The coordinate data displayed

currently indicate that X Position and Y Position correspond to the coordinates of the

object’s left bottom corner.

Array : copies the current object and arrange them to the destination by dealing

with the dialog box as shown in Fig. 2-17:

Fig. 2-17 Array Operation Dialog Box

Increment: the space between rows/columns, given by the user.

Fig. 2-16 shows the object’s situation when X=2 and Y=3.

Fig. 2-18 Array Operation Result

: sets the array’s row as marking precedence.

: sets the array’s column as marking precedence.
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: refers to the unidirectional marking.
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3. Edit Menu

The “Edit” menu carries out the editing operation of a graph, as shown in Fig. 3-1.

Fig. 3-1 “Edit” Menu

3.1.Undo (U)/Redo (R)

During graph editing, if the current operation is not satisfying, “Undo” can be used for

undoing current operation and bring the previous operation back; after the current

operation is undone, “Redo” can be used for redoing the undone operation. This is one of

functions most frequently used in editing.

The icon of the “Undo” menu in the Toolbar is , while the icon of the “Redo” menu in

the Toolbar is . Similar to most software, those two operations have their

corresponding shortcut keys, i.e. Ctrl+Z and Ctrl+Y respectively.
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3.2.Cut (T), Copy (C) and Paste (P)

“Cut” will delete the selected graph and copy it to the clipboard of the system. Then
“Paste” will copy the graph in the clipboard to the current graph. “Copy” will copy the
selected graph to the system clipboard and keep the original graph.

The shortcut keys of “Cut”, “Copy” and “Paste” are Ctrl+X, Ctrl+C and Ctrl+V respectively.

The offset of the pasted graph position with respect to the original graph position is
determined by “Paste X” and “Paste Y” in “General” of “System Parameter”.

3.3.Combine/Uncombine

“Combine” will ignore all the selected objects’ original properties and combine those

objects into a new curve object. This combined graph, like other graphs, can be selected,

copied, pasted and its properties can be set. For example, when the original graph is a

circular or a rectangular, but the graph after “Combine” operation is dealt with as a curve

and will be transformed into a curve after “Uncombine” operation.

“Uncombine” will get the combined object back to separate curves.

The icon of “Combine” in the Toolbar is , while that of “Uncombine” is . Their

shortcut keys are Ctrl+L and Ctrl+K respectively.

3.4.Group/Ungroup

“Group” will keep the selected objects’ original properties and make them into a new

object, and this new graph, like other graphs, can be selected, copied and pasted, and its

properties can be set.

For example, the original graph is circular or rectangular, but the graph after “Group”

operation will be dealt with according to the original properties and it will be restored to

the original graph, with properties unchanged, after “Ungroup” operation.

“Ungroup” will turn the object which has just been grouped into previous situation.

The icon of “Group” in the Toolbar is , while that of “Ungroup” is . Their shortcut

keys are Ctrl+G and Ctrl+U respectively.
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3.5.To Curve/Multi-line
Segment

This function is to remove the

properties of the selected graph and

transform it to a curve or multi-line

segment.

3.6.To Dashed Line

This function is to transform the vector graph to a dashed graph for marking, as shown in

Fig. 3-2:

Fig. 3-2 “To Dashed Line”

The user has to set the length of the short line and the space between lines, and then

click “OK” to transform the vector graph into a dashed one.

3.7.Offset

Offset the drawn vector graphic according to the offset distance. as shown in Figure 3-3 on the
left:：

Offset dist：The distance between the old curve and original curve.

Del Old curve：Whether to keep the original graphics. Unchecked means to keep the original
graphics. Check to remove the original graphics and keep only the offset.

Offset inwards: Select this option to offset the graphic internally.
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Arc Angle Transition: Check this item to make the corners rounded.

3.8.Ungroup Text

Ungroup the character text string into several texts, each of which contains only one

character.

3.9Hatch

“Hatch” is used for hatching a given graph. The graph to be hatched must be a closed

curve.

The icon of “Hatch” in the Toolbar is . When it is clicked, a dialog box will appear, as

shown in Fig. 3-4.
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Fig. 3-4 “Hatch” Dialog Box

Mark Contour: determines whether to show and mark the contour of the original graph,

namely, whether the hatched graph keeps the original contour.

Contour Precedence: indicates that the contour is marked first and then the hatch line is
marked when “Mark Contour” is clicked.

Hatch 1 / Hatch 2 / Hatch 3: indicates that there can be three sets of independent hatch
parameters for hatch calculation. The crossed hatch at any angle can be realized and

each kind of hatch can support four types of hatch to perform marking (four types of

hatching are: unidirectional/bidirectional/ring/optimized bidirectional hatch, as shown in

Software User manual EN 51



the following).

Enable: determines whether to permit the validity of the current hatch parameter.

All Cal: serves as an optimized option. If it is selected, all the mutually exclusive objects

will be calculated as a whole during hatch calculation, which will speed marking up on

certain occasions. (If it is selected, the computer’s calculation may slow down), If it is not

selected, each independent area will be calculated separately.

For ease of description, we now give a special example to illustrate this feature.

For example: draw three rectangles, line distance is 1mm, angle is 0

1、 Do not click ‘All Calc’, system will mark as the order in object list, mark hatch

line in the first rectangle then mark hatch line in the second rectangle, and so on

Fig.3-5 Do not click ‘All Calc’

2、 Click ‘All Calc’, mark all the hatch line at one time, mark all the hatch that on the
same line.
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Fig.3-6 Click ‘All Calc’

Type of Hatch：

Unidirectional Hatch: the hatch lines will be marked from left to right.

Bidirectional Hatch: the hatch lines will be marked from left to right first and

then from right to left, and the others are circular hatch.
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Fig.3-7 Left is Unidirectional Hatch，Right is Bidirectional Hatch

Ring Hatch: the hatch lines will be marked from outside to inside of the object

contour in a circular and skewing manner.

Optimized bidirectional hatch: It is similar to bidirectional hatch, but the ends of

hatch lines will connect.

Fig.3-8 Left is Ring Hatch,Right is Optimized bidirectional hatch

Optimization Gong type hatch: similar with Gong, will jump in null place
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Fig.3-9 Optimization Gong type hatch

Those five types of hatch can be switched over by clicking the button with the

mouse and can be set or modified conveniently and rapidly according to the required

effects.

Angle: the angle between the hatch line and the X axis

Fig. 3-10 Angle is 45

Line Space:the space between two adjacent hatch lines.

Edge Offset: the distance between hatch lines and the contour when “All Cal” is

selected.
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Fig 3-11 Line Space

(Left one line space is 0，Right one line space is 1)

Follow Edge One Time: adds a contour around the hatch lines after hatch calculation.

Evenly Distribute Hatch Lines: deals with uneven distribution of hatch lines at the

beginning and end of the hatched object. Due to the size of the hatched object, line space,

etc., the hatch lines at the beginning and end of the hatched object may be distributed

unevenly. To simplify the operation, this function is added so that the hatch lines can be

distributed evenly without any resetting of the line space by the user. After it is selected,

the software, based on the line space set by the user, will nudge the line space to ensure

the even distribution of hatch lines.

Start Offset: the distance between the first hatch line and the border of the object.

End Offset: the distance between the last hatch line and the border of the object.

Linereduction: the reduction of both ends of the hatch line. A positive value indicates

reduction and a negative value indicates extension. This function is used when the

distances between both ends of the hatch line and the contour line are expected to be

large during marking.

NumLoops: the times of ring hatch before the aclinicing hatch. The last ring cannot be

hatched evenly if only the ring hatch is used, so this function can solve such a problem.

[Note: the line space shall not be too large during text hatching, because a too large line

space will cause the hatch effect to be invisible.]
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Hatch one by one: choose multi object and hatch together, after hatch, still independent

object.Undo Hatch：delet hatching

Dissolve Group on Delete: Ungroup when you perform a delete operation.

Auto rotate hatch: Refers to after every marking, the hatch line will fill the revolving angle

which we setted automatically to marking again. For example, angle is 0, auto rotate angle is 30,

the first mark angle is 0, the second is 30, the third is 60, and so on

Multi-figure Operation: Default, Intersection, Union, Difference Set As shown in Figure 3-12,

the figure combination can be filled with different patterns.

.

Fig 3-12 The upper left is the default, the upper right is the intersection, the lower left is the union, and

the lower right is the difference
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4. Draw Menu
The “Draw Menu” is used for drawing various common shapes, including Point, Line,

Curve, Polygon, etc. This menu has a corresponding Toolbar, and all related operations

can be achieved through the icons in this Toolbar, as shown in Fig. 4-1. When you select

a drawing command or the icon in the Toolbar, the Present Command Toolbar on the top

of the workspace will be changed to show some options of the current command.

Fig a) “Draw”Menu Fig b) “Draw” Toolbar

Fig c) Select command toolbar

Fig4-1 “Draw” Operation

4.1. Point (P)

Drawing a point in the workspace is the simplest drawing operation. By selecting the

Software User manual EN 58



“Point” command in the menu and clicking the left mouse button at an appropriate

position in the workspace, you can draw a point at the position. Also you can draw more

points by clicking the left mouse button continuously. After drawing, you can click the right

mouse button to stop the point drawing command, and then the last point is displayed as

the selected object.

4.2. Line (L)

To draw a line, the user can select the command “Line” in the Draw Menu or click the icon

, or click and move the left mouse button when the “Line" command is selected.

When the “Line” command is selected, input the coordinates of points directly by clicking

the right mouse button, as shown in the following figure:

Fig. 4-2 “Input Coordinates”

4.3. Curve (S)

To draw a curve, the user can select the “Curve” command in the Draw Menu or click the

icon .
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Fig. 4-3 Curve Drawing

When the “Curve” command is selected, the user can draw curves freely by pressing the

left mouse button and moving the mouse.

When the “Curve” command is selected, the user can move the mouse cursor to the

beginning node of the curve and press the left mouse button to close the current curve

automatically.

4.4. Rectangle(R)

To draw a rectangle, the user can select the “Rectangle” command in the Draw Menu or

click the icon.

When the “Rectangle” command is selected, the user can press the left mouse button

and move it to draw a rectangle.

When the “Rectangle” command is selected, the user can draw a square by pressing the

left mouse button and the “Ctrl” key simultaneously and moving the mouse.

When a rectangle is selected, the rectangle properties as shown in Fig. 4-4 will be

displayed in the Properties Toolbar.
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Fig. 4-4 Rectangle Properties Toolbar

Corner Roundness: It refers to the roundness of the rectangle’s four corners. If the

roundness is 100%, the corner turns into an arc.

All Corners Round: When it is activated, the user can modify the roundness of the four

corners by just modifying one of them.

NOTE: Whenever the parameters in the Properties Toolbar are modified, it is a
must to click the “Apply” button to effect the modification, which applies to the
following operations.

4.5. Circle (C)

To draw a circle, the user can select the “Circle” command in the Draw Menu or click the

icon .

When the “Circle” command is selected, the user can press the left mouse button and

move the mouse to draw a circle.

When a circle is selected, the circle properties as shown in Fig. 4-5 will be displayed in

the Properties Toolbar.

Software User manual EN 61



Fig. 4-5 Circle Properties Toolbar

Diameter: the diameter of a circle.

Start Angle: the angle of the starting point of a circle relative to its center.

: It means the current circle is marked clockwise.

: It means the current circle is marked anticlockwise.

4.6. Ellipse (E)

To draw an ellipse, the user can select the “Ellipse” command in the Draw Menu or click

the icon .

When the “Ellipse” command is selected, the user can press the left mouse button and

move the mouse to draw an ellipse.

When the “Ellipse” command is selected, the users can draw a circle by pressing the left

mouse button and the “Ctrl” key simultaneously and moving the mouse.

When an ellipse is selected, the ellipse properties as shown in Fig. 4-6 will be displayed

in the Properties Toolbar.
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Fig. 4-6 Ellipse Properties Toolbar

Start Angle: the angle of the starting point of an ellipse relative to its center.

End Angle: the angle of the ending point of an ellipse relative to its center.

: It means the current ellipse is marked clockwise.

: It means the current ellipse is marked anticlockwise

4.7. Polygon (M)

To draw a polygon, the user can select the “Polygon” command in the Draw Menu or click

the icon .

When the “Polygon” command is selected, the user can press the left mouse button and

move the mouse to draw a polygon.

When a polygon is selected, the polygon properties as shown in Fig. 4-7 will be displayed

in the Properties Toolbar.
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Fig. 4-7 Polygon Properties Toolbar

Edge Num.: It refers to the number of a polygon’s edges with the minimum number of

three.

4.8. Text (F)

Inputting characters directly in the workspace is supported in SeaCAD, and the fonts

include all those supported by the system and many others set in the SeaCAD. To input

characters, the user can select the “Text” command in the Draw Menu or click the icon

.

When the “Text” command is selected, the user can create text objects by clicking the left

mouse button.
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Fig. 4-8 Text Properties Toolbar

If you need to modify the text, you can directly modify it in the text edit box.

SeaCAD supports four types of fonts (TrueType fonts, single line fonts, barcode fonts,

bitmap fonts) and other fonts that are installed independently.

After selecting the font type, the font list will list all fonts of the current type

accordingly, as shown in Figure 4-9 is a TrueType font list.
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Fig. 4-9 TrueType List

Height: The average height of the font.

4.8.1. Font Parameters

When a text is selected, the text properties as shown in Fig. 4-10 will be displayed in the

Properties Toolbar.
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Fig. 4-10 Font Properties

Alignment: “Left”, “Center” and “Right” mean that the current text is aligned to the

left/center/right respectively.

Bold:When selected, the current text become bold.

Italic:When selected, the current text become italic

Sorting direction: Horizontal means Horizontal arrangement, Vertical means vertical

arrangement.

Enable the Same Width Character: make all characters keep the same width.

Char Width: the average width of characters.

Char Angle: the angle of inclination of characters.

Char Space: the distance between characters.

Line Space: the distance between two rows of characters.

Circle Text：SeaCAD supports circular text, the text will align according to the user definition circle

diameter.As show in figure 4-11.
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Fig. 4-12 Path Circle Text

Circle Diameter：diameter of circle text。

Base Angle: the angle benchmark for text alignment.

Fig. 4-12 First one base angle is 0，Second one base angle is 90.

Angle Range Limit: When it is selected, the text will be limited in the angle range limit no

matter how many characters are input.as shown in Fig. 4-13

。As show in Fig 4-13：
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Fig. 4-13 Left is click Angle Range limit，Right one is not。

Reverse：Reverse the text。

Invert：Invert the text。
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4.8.2. Path

Draw a circle, select the “Text” command and click the circle edge to get the text. The

pattern is as shown in Fig. 4-14.

：

Fig. 4-14 Path Circle Text

After the icons, , are clicked, a dialog box will pop out as shown in Fig.4-15.

Fig. 4-15 Path Text

Base Angle: the angle benchmark for text alignment.

Angle Range Limit: When it is selected, the text will be limited in the angle range limit no

matter how many characters are input.

Text inside the arc：Put the text inside the arc as show in flowing fig.
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Fig. 4-16 Text inside the arc

Align the top of the text：means the top of the text is superposition with the curve, as

show in flowing fig.

Fig.4-17 Align the top of the text

4.8.3. Barcode Text

When the Barcode Font is selected, a dialog box will pop out as shown in Fig. 4-19 after

the icon is clicked.
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Fig. 4-19 Dialog Box of Barcode Font Parameters

Show Text: determines whether to show a corresponding text for identification under the

barcode.

Pen No：Select the pen number for the text, the default is the same as the barcode.

Font: the font of the current text to be displayed.

Height: the average height of the text.

Width: the average width of the text.

Text X Offset: the coordinates of text offset in the direction of X axis.

Text Y Offset: the coordinates of text offset in the direction of Y axis.
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Text Space: the space between characters.

4.8.3.1. One-dimensional Barcode

It consists of “bar” and “space” arranged one by one. The barcode information is

carried by different widths and positions of bar and space, and the information volume is

decided by the width and the precision of barcode. The wider the barcode is, the more

bars and spaces are included, and the more information is carried. This kind of barcode

technology can store information in only one direction through permutation and

combination of bars and the spaces, so it is called one-dimensional barcode.

Fig. 4-20 shows the parameter setting in the window when a one-dimensional barcode is

selected.

Fig. 4-20 One-dimensional Barcode Parameters

Black and White Invert: determines whether to invert the marking. This function is used
for some materials which are light-colored after marking.

Bar Height: the height of the barcode.

Standard Width: It refers to the width of the narrowest bar, i.e. the width of the unit bar.

Commonly a one-dimensional barcode consists of bars and spaces with four types of

width respectively, and 1, 2, 3 and 4 refer to 1, 2, 3 and 4 times the width of the unit bar

as per the width size of bars and spaces. The width of the narrow bar means the width of

one unit bar.
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The actual width of Bar 2 is a scale of the narrow bar width multiplied by the width of Bar

2, and the method applies for Bar 3 and 4.

The actual width of Space 1 is a scale of the narrow bar width multiplied by the width of

Space 1, and the method applies for Space 2, 3 and 4.

Quiet: It refers to the limited area where the reflectivity at the outer ends or middle of the
barcode is the same as that of the space. The actual width of the Quiet area is a scale of

the narrow bar width multiplied by the Quiet area.

4.8.3.2. Two-Dimensional Barcode

4.8.3.2.1. PDF417Barcode

PDF is the abbreviation of the Portable Data File. Figure 4-21 is the demonstration of

PDF417 Barcode.

Bar Height: the height of the barcode
Narrow Width: This refers to the width of the unit bar.
Level: the Error-Checking Level of PDF417 barcode, from 0 to 8

Lines and Columns: the lines and Columns of PDF417 barcode

Fig. 4-21 PDF417 Barcode
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4.8.3.2.2. DataMatrix Barcode

DataMatrix is a kind of two-dimensional barcode based on Matrix, as shown in Fig.

4-22:

Data Matrix has various fixed size, and users can choose what they want.have, If the

smallest size is chosen, the system will automatically select the smallest frame to fit the

all text users

Fig. 4-22 DataMatrix Barcode

4.8.3.2.3. QR-Code

QR-Code Barcode is a kind of two-dimensional barcode and its character set includes all

ASCII values, as shown in Fig. 4-23:
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Fig. 4-23 QR-Code Barcode

Custom display text：User can use commands to display the text you want to display. #-

represents the character that shows the current position,? - represents the character that deletes the

current position, %- represents the position number of the character that displays the current

position, and -/ is a line-up display character string. For example:

Dot Mode, Circle Mode, and Rectangle Mode: Select the mode that makes up the
two-dimensional code. The examples are as follows (from left to right, dot mode, circle

mode, rectangle mode):
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The proportion of graphics width：Set the size of the element which formed

two-dimensional code. The adjustment range is from 1 to 100. It is valid only for the circle

mode and rectangle mode.

Fixed size：Set the size of the two-dimensional code.

Center blank：An area will be vacated in the center area of the QR code , which will be

used to place company LOGO, pictures, etc.

4.8.4. Variable Text

The Enable Variable Text will be available after is selected, and the

variable text properties as shown in Fig. 4-21 will be displayed by the system. The

“Variable Text” means that a text can be modified dynamically based on the rules given

by the user during marking.
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Fig. 4-24 Variable Text Properties

Distance Control: the distance between characters as per the current character

arrangement pattern.

Spacing: It refers to the distance from the right boundary of left character to the left

boundary of right character.

Fig.4-25 Spacing

Center Distance: It refers to the distance from the center of left character to the center of

right character.as shown in Fig. 4-26
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Fig.4-26 Center Distance

The user may add various variable text elements as required and sequence the text

elements. After the “Add Text Element” is selected, the dialog box as shown in Fig. 4-27

will pop out.
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Fig. 4-27 Text Element Dialog Box

Fixed Text: It refers to the invariable element in the text during marking.

Serial Number: It refers to the element changing with the fixed increment during
marking.

Date Code: The system will automatically read date information from the computer

during marking.

Time: The system will automatically read time information from the computer during

marking.

TCP/IP Communication: The system will read the text to be marked through the network

during marking.

Serial Communication: The system will read the text to be marked through the serial

port during marking.

SQL Database: The system will automatically read the text to be marked from the

connected database during marking.

Text: Text to be processed are read directly from the "TXT" "EXCEL" file .

Keyboard: The elements of the text to be processed are entered by the user from the keyboard
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during processing.

4.8.4.1. Fixed Text Element

It refers to the invariable element during marking.

Fig.4-28 Fixed Text Element

Newline character: Applied to the variable text function to solve the problem of multiple

lines that require branch marking. When applied, a new line character is added between

the two texts, and the software automatically branches the text according to the position

of the newline character. If multiple texts need to be split into multiple lines, simply add a

line break after the text to be split

Username: When this option is selected, the system automatically replaces the current user name
using SeaCAD with a fixed text.

4.8.4.2. Serial Number Element

The serial number element is a text element which changes with the fixed increment

during marking.

When the Serial Number is selected, the serial number parameter definition will
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automatically be displayed in the text element dialog box, as shown in Fig. 4-29.

Fig.4-29 Serial Number Element

Start SN: the first serial number to be marked at the moment.

Current SN: the serial number to be marked at present.

Limit SN: When it comes to the marking of limit serial number, the system will return to

the start serial number automatically.

Increment: It refers to the increment of the current serial number. When set as a negative

value, the serial number will decrease progressively.

When the increment of the current serial number is 1, and the start serial number is 0000,

each number will be added with 1 based on its previous number, for example, 0000, 0001,

0002, 0003 … 9997, 9998, 9999. When it comes to 9999, the system will return to 0000

automatically.

When the increment of the current serial number is 5, and the start serial number is 0000,

the serial numbers are: 0000, 0005, 0010, 0015, 0020, 0025…..and so forth.
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Marks Per: the number of serial numbers to be marked required for the change of serial
number per time.

Current Marks.: The marking times of the current serial number. When it equals to Marks

Per, it will turn to 0 automatically.

Mode: the carry mode of the current serial number.

: The system will filter out serial numbers whose certain digit

is a particular value after it is selected. The means that the serial numbers with 4 as

the tail number will be filtered out, and the * can be numbers with any digits.

Reset: You can customize the reset time or reset every point. Every day this time, the
serial number of the mark changes to the start sequence number.

：Stop the marking task after you finish the Specified sequence number。

4.8.4.3. Date Code

Date Code: The system will automatically read date information from the computer

during marking.

When the Date Code is selected, the date parameter definition will be displayed in the

text element dialog box automatically, as shown in Fig. 4-22.
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Fig. 4-30 Data Code Parameter Definition

Year-2017: takes the year indicated by the current computer clock as the corresponding

text with four characters.

Year-17: takes the year indicated by the current computer clock as the corresponding text
with two characters: only the latter two digits are taken.

Month-06: takes the month indicated by the current computer clock as the corresponding
text with two characters.

Day-05: takes the date of each month indicated by the current computer clock as the

corresponding text with two characters.

Day-156: takes the number of days from January 1 to the date indicated by the current

computer clock as the corresponding text with three characters. (001 represents January

1, 002 represents January 2, and so on).

Day of Week-01: takes the day of week indicated by the current computer clock as the

corresponding text with two characters.

Week of Year-18: takes the week of year of the date indicated by the current computer

clock as the corresponding text with two characters (take the period from January 1 to the

Software User manual EN 85



first Saturday as the first week).

Date Offset: When the system reads the date indicated by the computer clock, it is

necessary to add the set offset-date to obtain the marking date. This function is mainly

used for the marking of workpieces with production date and shelf life in food industry and

the like.

4.8.4.4. Time Element

The system will automatically read time information from the computer during marking.

When the Time Element is selected, the time parameter definition will automatically be

displayed in the text element dialog box, as shown in Fig. 4-23.

Fig. 4-31 Time Parameter Definition

Hour-24: takes the time in hour indicated by the current computer clock as the

corresponding text in the 24-hour time system.

Hour-12: takes the time in hour indicated by the current computer clock as the

corresponding text in the 12-hour time system.

Minute: takes the time in minute indicated by the current computer clock as the

corresponding text.

Second: takes the time in second indicated by the current computer clock as the

corresponding text.

Time section: 24 hours of one day are divided into 24 time sections, and the user can

define a text for each time section. This function is mainly used for the marking of

workpieces requiring the shift information.

。
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4.8.4.5. TCP/IP communication

When the operation is taking place, the system will pick up the text from the network.

Notice: The network interface in here is the network interface uses in TCP/IP
agreement.When the user selected the “TCP/IP communication”, the parameter defines

will display automatically in the dialog box, see the figure 4-24:

Fig.4-24 TCP/IP communication

IPAddress: select the IP address which from reads the data

Port: select the port the TCP/IP communication used

Command: When the system processes to this text object, the system through the

network interface to transmit this order character string to a computer assigned the IP

address,request the computer sends the character string needs to process at present,

the system will not return until the computer replied, after the response of the

computer, the system will process the returns text automatically.

Unicode: After choosing this option, the system to the computer transmission which and

the read character is the Unicode form, otherwise is the ASCII form.
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Timeout setting: You can set the timeout period for connecting the specified IP address
and receiving data.

4.8.4.6. Serial communication

When the operation is taking place, the system will pick up the text from the serial port.
When the user selected the “Serial communication”, the parameter defines will display
automatically in the dialog box, see the figure 4-25.

Fig.4-25 Serial communication

Port: the port which computer and peripheral equipment connection used
BaudRate: the BaudRate which the serial communication used
DataBits: the DataBits which the serial communication used
StopBits: the digits of StopBits of which the serial communication used
Parity: select the digits of Parity which the serial communication used
Command:When the system processes to this text object, the system through the serial

port to transmit this order character string to a peripheral equipment, request the

peripheral equipment sends the character string needs to process at present, the system

will not return until the peripheral equipment replied, after the response of the peripheral

equipment, the system will process the returns text automatically

Display part of data: check to show characters between specified bits
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4.8.4.7. File

TXT ：When select TXT file, a dialog box as Figure 4-26 shows will be displayed to ask

for the file’s name and the current text’s line number.

Auto reset: If checked, the line number will change to 0 automatically when reach the
last line. The next mark will start from the first line again

Read all lines:When processes to the text document direct read entire

Document.

Fig.4-26 TXT

EXCEL：We have to appoint the file name, Field name, Line number to tell the software

which cell in the excel table will be mark

File name: The text string of the first row in the datasheet1. This parameter indicates

which

column will be marked
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Fig. 4-27 EXCEL

4.8.4.8. Keyboard

The keyboard element is the text which must process from the keyboard entry by the

user,when select the keyboard element, a dialog box as Figure 4-47-a shows will be

displayed to ask for the user set the keyboard element parameter
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Fig.4-28 Keyboard

Fixed char count: user must input string with digit equals to this count

.
Set Pen Param: When selected, we can get power, speed, frequency from the keyboard
entry,only through setting pen*.power, pen*.speed or pen*.freq. The “*” is number of pen.

The keyboard element function uses frequently in this kind of situation when the
processing needs the real-time input to the processing content. If the customer present
need processes one batch of work pieces, on each work piece is printed with a bar code,
when processing needs the user with the bar code scanning gun real-time scans the
work piece to read the content on the bar code, then with laser to mark to the work piece
assigns in the position, at this time can use the keyboard element function. At the
processing time system springs like the figure 4-30 shows the dialog box, the operator
with the bar code scanning gun scanning bar code work piece on, the bar code scanning
gun inputs the read content to the dialog box inside and closes it automatically, then the
system will start to process the content read a moment ago automatically .

4.8.4.9. Advance Function

After the “Advance” function is selected, the dialog box as shown in Fig. 4-29 will pop out.

Fig.4-29 Advance Function

 Mark Self: In certain situations, when the user needs to split the variable text and

then mark them in different positions, and also needs to mark the variable text, this

function is applicable. It is conducted by setting the parameters for character splitting and

selecting “Mark Self”. During marking, besides the split character, all input variable texts

will be marked in corresponding positions.

 Select “Enable Split String to Change Other Text Entity”, and click “Add” button to
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get the dialog box as shown in Fig. 4-30.

Fig.4-30 Advance Function

Index of the First Character in String: the order of the first character in the character

string of variable TEXT1 text.

The Number of Characters to Extract from String: extracts a certain number of

characters starting from the first character in the character string of variable text.

The Name of Text Entity Which You Want to Change: When it is selected, it is

necessary to input the name of a fixed text for the character to be split and read.

Add Char Mode: when it is selected, the split and read character will be added to the

position following the fixed text.

For example:

1. Create a new variable text (take a variable serial number text as an example)

2. Click “Advance” in the Variable Text Properties Toolbar, and select “Enable Split

String to Change Other Text Entity”, as shown in the following figure:
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Fig.4-31

3. When “Add” is clicked, the following dialog box will pop out (it means that two

characters starting from the first character in the variable text are extracted to replace the

content in the fixed text entity with an indicated name)

Fig.4-32

4. After clicking OK, draw another fixed text entity, and modify its name as per the name

set as above.

4.9. Bitmap

4.9.1. Input Bitmap

To add a bitmap, the user can select the “Bitmap” command in the Draw Menu or click the
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icon .

Fig. 4-33 Bitmap Inputting Window

The system will pop up the input dialog box as shown in Figure 4-33 and ask the

user to select the bitmap to be input. The currently supported bitmap formats are: Bmp;

Jpeg,;jpg; Gif; Png; Tiff; Tif; Emf. The system will automatically display the picture of

the current file in the preview box, and will also put the center of the current picture on

the origin of the coordinates.

After entering the bitmap, the property toolbar displays the bitmap parameters as

shown in Figure 4-34.
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Fig.4-34 Bitmap parameters

4.9.2. Invert

Invert: takes the opposite color value for each point of the current image, as shown in Fig.
4-35.
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Fig. 4-35 Inverted Image

4.9.3. Grey Scale

changes a color image into a 256-level grey scale image, as shown in Fig. 4-36.

Fig. 4-36 Grey Scale Marking

4.9.4. Fixed DPI

It is similar to the resolution of images. When the DPI value of the original bitmap is
not fixed or unclear, the fixed DPI value can be set by means of “Fixed DPI”. The higher
the DPI level is, the closer the dots gather, the higher the photo precision is and the
longer the marking time is.。

4.9.5. Dither

Dither: This effect is similar to the “Halftone Pattern” function in Adobe PhotoShop. It

uses a black-and-white image to simulate a grey scale image and achieves different grey

scale effects by adjusting the density of points based on black and white colors, as shown
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in Fig. 4-37.

Fig.4-37 Dither

4.9.6. Bidirectional Scan

The scanning is bidirectional during the marking of bitmaps.

4.9.7. Drill Mode

Determines whether the laser is kept on or for a scheduled period for each pixel during

the marking of bitmaps.

4.9.8. Adjust Power

Determines whether the laser’s power is adjusted according to the grey scale of each

pixel during the marking of bitmaps.
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Fig.4-38 Power Map

4.9.9. Expand Parameter

Expand Parameter: Figure 4-39 。

Y Scan: The scan will run along Y axis line by line

Scan line Increment: This item indicates whether to scan line by line or skip some lines.

This function may quicken the marking speed when in low precision marking requirement

Disable Mark Low Gray Point: This item indicates that every point is marked or only

marking bigger gray points. This function may quicken the marking speed when in low

precision marking requirement

Line feed malposition: The point isn’t aligned between two adjacent rows, but the point

is aligned with the position which is the middle of two points in the previous line, to avoid

the trace of marking 。

Optimize Mode: calculate the marking speed according to the DPI and frequency to

optimize marking speed and result 。

ACC.Distance:this parameter is used for remove the offset of BiDir scan model

BiDir Offset: improve the edge not alignment marking problem
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图

Fig.4-39 Expand Parameter

4.10. Vector File

To input a vector file, the user can select the “Vector File” command in the Draw Menu or

click the icon .

The bitmap formats supported by the current system include PLT and DXF. The Fig. 4-40

shows the result of vector image import.
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Fig. 4-40 Vector Image Import

4.11. Time-lapser

To input the control object of delayer, the user can select the “Delayer” command in the

Draw Menu or click the icon.

When the “Delayer” is selected, the delayer property as shown in Fig. 4-41 will be

displayed in the Properties Toolbar.

Fig. 4-41 Delayer Property

Waiting time: When the marking comes to the current delayer, the system will wait for a

scheduled period and then continue to operate.

4.12. Input Port

To input the control object of input port, the user can select the “Input Port” command in
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the Draw Menu or click the icon .

After the “Input Port” is selected, the input port properties as shown in Fig. 4-31 will be

displayed in the Properties Toolbar.

Fig. 4-42 Input Port Parameters

I/O Control Condition: When the marking comes to the current input port, the system

will read the input port and compare the read value with the I/O Control Condition; if the

two equal, the system will proceed to the following ports, and otherwise it will read the

port again.

Message: It is given by the system when it reads the port repeatedly and waits for the

matching between the port value and the I/O Control Condition.

4.13. Output Port

To draw the control object of output port, the user can select the "Output Port” command

in the Draw Menu or click the icon .

After the “Output Port” is selected, the output port property as shown in Fig. 4-43 will be

displayed in the Properties Toolbar.
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Fig. 4-43 Output Port Parameters

The system will provide the port with high-level voltage when the marking comes to

the current output port.

The system will provide the port with low-level voltage when the marking comes to

the current output port.

The system will provide the port with a level signal and keep it.

The system will provide the port with a pulse signal and it can set the pulse width.

4.14. External Axis

Fig.4-49 External Axis

External Axis 1、 External Axis 2：Select which external axis to use for operation.

Correct axis origin: The current expansion axis go zero and reset coordinates.The
following example explains how to use this module.

Relative position: It means the origin is used as the reference when the motor moves

Number of moving pulses: how many pulses are sent to the motor, and the number of
pulses indicates the motor movement distance.

Unit：unit of motor movement distance

4.15. Encoder Movement Distance

When the “Encoder Movement Distance” command in the Draw Menu is selected, the
“Encoder Movement Distance” will be displayed in the Object List as shown in Fig. 4-50
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Fig. 4-50 Dialog Box of Encoder Movement Distance

“Encoder Movement Distance” is mainly used for detecting the movement distance of

flying objects during the process of mark on the fly.

4.16. Helical Line

The helical line can be added to objects outside the frame and the following parameters

can be set: equal pitch, unequal pitch and helical line setting from inward to outward or

from outward to inward, as well as the minimum radius, the minimum and maximum

pitches of helical line, variation of pitch, number of rings of outer and inner boundaries,

etc., as shown in Fig. 4-51:

Fig. 4-51 Helical Line Setting Dialog Box
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4.17. Graph Selection

The icon on the top of the Draw Toolbar is used for graph selection.

The depressed state of the icon indicates that the command is selected at that time if no

other command is selected, and you can select an object by clicking objects in the

workspace with the mouse. The software has the “Auto-snap” function, and you can

select an object by clicking the left mouse button if the mouse cursor is near a curve in

the workspace.

You can also press the left mouse button and move the mouse to select an object,

and there will be a dashed frame in the area where the mouse moves through. Objects

wholly included in the dashed frame will be selected.

When the “Select” command is selected, the Select Toolbar will be displayed, and

you can realize some particular operations, as shown in Fig. 4-44:

Fig. 4-44 Select Toolbar

It means that the current object is locked and you can’t conduct any editing

operations on it. Some lock-like icons will appear around the object at that time.

It means unlocking locked object selected currently.

It means unlocking all the locked objects.

It means placing the selected object to the origin.

It means selecting objects by the pen number. The dialog box as shown in Fig. 4-45

will be displayed after the command is selected.
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Fig. 4-45 Dialog Box of Selection by Pen Number

Indicates that the current selection object will be mirrored horizontally。

Fig.4-46 Mirrored horizontally

Indicates that the current selection is vertically mirrored：

Fig.4-47 Vertically mirrored

Show or hide the current figure’s marking path ：
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FIg.4-48 Figure’s marking path
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5.Modify Menu
Commands in Modify Menu will take easy operations on selected objects, such as

transformation, Plastic, Curve Editing, Aligning, etc. (Fig. 5-1)

Fig. 5-1 Modify Menu

5.1. Array

Click “Array”, we can see the dialog box as shown in Fig. 5-2:

Fig. 5-2 Array Dialog Box

Rectangle: The graph according to rectangle array.

Circle: The graph according to circle array.

: Present the graph in undirectional array as per marking sequence.

: Present the graph in bidirectional array as per making sequence.
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Array Num: The row number.

Array Num: The column number.

Array: The space between two objects on X direction.

Array: The space between two objects on Y direction.

Calculate by Offset Distance: The space of the graphs is calculated by offset distance.
(Fig. 5-3 (a))

Fig. 5-3 (a) Calculate by Offset Distance (b)

Calculate by Graph Distance: The space of the graphs is calculated by graph distance.
(Fig. 5-3 (b))

If we select the array type of “Circle”, we can see the dialog box as shown in Fig. 5-4:

Fig. 5-4 Array Dialog Box (Circle)

: The graph’s array is clockwise or anticlockwise, which sets the marking sequence.

Array Number: The graph number.
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Radius: The radius of the circle.

Start Angle: The angle between the starting graphs of the circle.

Angle: The angle between two graphs.

5.2. Transformation

When selected, a parameter setting box will appear as shown in Fig. 5-5.

Fig. 5-5 Transformation Setting Box

5.2.1.Move

: Stroll tool for moving objects

Position: The coordinates of the currently selected object datum mark.

This function is the same as the Position which is introduced in object label of properties

toolbar in Chapter 2.

Select a datum mark of an object.

Relative Position: use relative coordinates
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: Activate the modification.

: This item is used to copy the currently selected object and move it

into a new place.

5.2.2. Rotate

: Rotate your object.

When selected, a parameter setting will appear in the Rotation Setting Dialog Box as

shown in Fig. 5-6.

Fig. 5-6 Rotation Setting Box

Angle: Angle to rotate.

Center: The coordinates of the currently selected object’s datum mark.

This function is the same as the Center which is introduced in object label of properties

toolbar in Chapter 2.

: Select a datum mark of an object.

Apply to copy object

Apply
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Relative Center: Change the current coordinates into relative coordinates.

: Apply. Let the modification of the current object active.

: This item is used to copy the currently selected object and rotate it

into a new place.

5.2.3.Mirror

: Mirror the currently selected object.

When selecting mirror command, a parameter setting box will appear as shown in Fig.

5-7.

Fig. 5-7 Mirror Setting Box

Scale: The zoom ratio of the X/Y size after being mirrored.

: The current object’s horizontal mirror.

: The current object’s vertical mirror.

The vertical mirror and horizontal mirror can be activated at the same time, activate the

Apply to copy object

Apply
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corresponding mirror functions as per requirements in actual use, and make sure not to

press the function that is not required.

: Select a datum mark of an object.

: Let the modification of the current object active.

: This item is used to copy the currently selected object and mirror it

into a new place.

5.2.4. Zoom

: Zoom your objects.

When selected, a dialog box will appear as Fig. 5-8.

Fig. 5-8 Zoom Setting Box

Size: The size after zooming. This function is the same as the Size which is introduced in
object label of properties toolbar in Chapter 2.

Apply to copy object

Apply
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: Select a datum mark of an object.

: Let the modification of the current object active.

: This item is used to copy the object and zoom it into a new place.

5.2.5. Lean

: Lean the currently selected object

When selected, a parameter setting box will appear as shown in Fig. 5-9.

Fig. 5-9 Lean Setting Box

Angle: The angle the object leans.

: Select a datum mark of an object.

: Let the modification of the current object active.

: This item is used to copy the currently selected object and lean it into

Apply to copy object

Apply

Apply to copy object

Apply
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a new place.

5.3. Plastic

When selected, a parameter setting box will appear as show in Fig. 5-10.

Fig. 5-10 Plastic

: Joint two close intersect areas into one.

: Shear a close intersect area contained in another.

: Pick up the intersect part of two close intersect areas.

5.4. Trim

Trim is used for shearing curve in graph. After users select it and when the mouse is

moved to the curve to be sheared, the mouse will be of a scissor shape and the the curve

to be sheared will become light blue, as shown in Fig. 5-11. By clicking the left mouse

button at this time, the curve will be sheared.
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Fig. 5-11 Example of Trim Operation

5.5. Break Cross Point

When users click “Break Cross Point”, the following dialog box as shown in Fig. 5-14 will

pop-up:

Fig. 5-12 Dialog Box of Breaking of Cross Point

Length of Cross Point: It means the length of the cross line part that we designed, as

shown in Fig. 5-12. Take the following Fig. 5-13 for example:

(a) Before Breaking Cross Point (b) After Breaking Cross Point

Fig. 5-13 Example of Breaking Cross Point

Software User manual EN 115



5.6. Auto-Connect:

When selected, a dialog box will appear as shown in Fig. 5-11.

Auto-Connect Error: If the distance between two curves’ starting and ending points is

less than the parameter set, the two curves will be jointed into one.

Fig. 5-14 Auto-Connect Dialog Box

5.7. Resort

Select this command in the modify menu or select from the main interface。The
software will mark through your chosen direction

Figure.5-14 Resort

5.8. Align

Command “Align” will be available only when more than one object is selected in the

workspace. “Align” is used to align the objects users select on the two-dimensional plane.

There are several ways to align:

Left: All objects align left.

Right: All objects align right.

Vertical: All objects align vertical.

These three ways above only support to move objects on horizontal direction.

Top: All objects align top.

Bottom: All objects align bottom.
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Horizontal: All objects align horizontal.

These three ways above only support to move objects on vertical direction.

Center: All objects align center. This way may cause moves on both horizontal and

vertical directions.
Note: The benchmark to align is according to the last object users select, and other
objects align behind it. If you select several objects by “Frame Select”, then the system
will hardly identify which is the last one, and this may cause unexpected alignment. It is
strongly recommended that you select the object which is to be the benchmark at the end
when you want to align several objects.
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6. View Menu
The View Menu is used for setting every option for view in the SeaCAD, as shown in Fig.

6-1.

Figure.6-1 View Menu

6.1. Zoom

The Toolbar of the zoom Menu is , and there are seven

types for different requirements.

: This item is used for filling the whole view area with the appointed area. Users may

use mouse to select rectangle area to zoom in. If pressing the right button of the mouse,

the current view will zoom out for one time with the mouse pointer’s position as the center;

and if pressing the left button of the mouse, the current view will zoom in for one time with

the mouse pointer’s position as the center.

: To move the current view.

: Zoom in.

: Zoom out.
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: Fill the whole view area with all the objects.

: Fill the whole view area with only the selected objects.

: Fill the whole view area with the whole workspace.

6.2. Ruler/Gridding/Guide Line

There are Horizontal Gauge, Vertical Gauge, Gridding and Guide Line for selection.

6.3. Snap Grid

This item is used for automatically putting the dots you draw on the grid.

6.4. Snap Guide Line

This item is used for making objects approach to guide lines automatically when moving

the object.

6.5. Snap Objects

During performing some operations, this item is used for automatically snapping an

object’s top, center, nodes, circle center, intersect points, etc.

6.6. System Menu Bar/Toolbar/Status Bar/Interface Window
Bar

SeaCAD supports many toolbars to achieve different functions. Toolbars can be either

displayed or hidden by selecting corresponding options in View Menu; and also the

Status Bar can be displayed or hidden, either. When there is a “√” selected in front of the

submenu, the corresponding toolbars on Status Bar is visible, and if not, they are hidden.

6.7. IO State

Check current input and output state, follow fig 6-3
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Figure.6-2 IO Status

6.8. Path preview

Select this function to see the path of the drawing.
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7. Special

特殊菜单在 SeaCad 软件中的各种选项，如图 7-1 所示。

Figure.7-1 Special

7.1. Change Text

Click change text, follow dialog window will pop-up, as fig 7-1

Figure 7-2 Change Text

The content under ‘text’ is to be replaced, the content under ‘change to’ is that after
replace.

7.2. Serial number text

All serial numbers under the current file are directly increased or decreased
according to their respective increments.

Or reset to the starting serial number without marking.
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8. Laser
“Laser” menu mainly aims at expansion axis control, as shown in Fig. 7-1 below:

Figure.8-1 Laser

8.1. Rotate and Move test

“Rotary Marking” is performed according to the angle of rotation axis.

Click “Rotary Marking” under “Laser” menu, and the following dialog box will display:
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Figure.8-2 Rotate and Move test

Axis ID： Choose Axis X ,Y, Z, U。

Invert: It refers that the expansion axis rotates in the opposite direction. When it is
checked, it means the expansion axis will invert;

Pulses per Round: The pulse (subdivision of driving motor) numbers each round that
the expansion axis rotating. It can be set according to the motor parameter.

Distance per Round：The distance each round that the expansion axis rotating，Click the
setting button "..." to calculate a more accurate distance per round.
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Figure.8-3 Extended axis accuracy setting

Min Coordinate: The smallest coordinate in which the extended axis can move, in
millimeters.

Maximum Coordinate: The maximum coordinate of the extended axis that can be
moved, in millimeters.

Min. Speed: The minimum rotary speed of expansion axis.

Max. Speed: The maximum rotary speed of expansion axis.

Acc. Time: Acceleration time needed when expansion axis moves from minimum speed
(starting speed of motor) to maximum speed.

Offset Compensation: It refers to the correction to position offset. Perform either
positive correction or negative correction.

Go to Start Position After Finished: When it is checked, the expansion axis will go
back to the initial position after finishing marking.

Start Speed：Set motor start speed, unit is pulse/s。

Motor Speed: The rotating speed of motor.

Rotation axis: Select it, it's indicates that current expansion axis is rotation axis. Moving
manner is rotation; otherwise, it indicates flat content processing or Z axis locating
process.

Reduction ratio：If the motor is directly connected to the shaft, the reduction ratio is 1; if
there is a reduction mechanism in the middle, it is the reduction ratio of the reduction
mechanism.

Part Diameter: It is used for setting the external wall diameter of round parts and
converting graphs in workspace into the accurate rotation angle.

Zero: Whether current expansion axis has zero signal. When expansion axis has not
activated zero signal, it cannot set up an absolute coordinate system. Then, it is required
to manually adjust the site to make every processing stay in the same site. The system
takes the current expansion axis point as default original point before processing.

If the zero is selected, the system will automatically look for zero point when employing
the expansion axis function. After finding the zero point, an absolute coordinate system
will be built for the expansion axis. If the system fails to find the zero point, the expansion
function will not be activated properly until the time set for “Zero Time Out” is over.

Speed of Go Zero: The moving speed of expansion axis looking for zero signal.

Zero Time Out: Set the time of expansion axis finding zero point. If it overruns, the
system will present “overtime”.

Accurate Zero: When it is selected, it is required to receive three signals before going

Software User manual EN 124



back to zero; if not selected, only one signal is required for going zero.

Gap compensation: Used to set the interval compensation between each independent
figure. For example, the interval between two figures is set to 10mm. If the mark is 10.1,
then the gap compensation bit - (10.1-10) =- 0.1.

Offset compensation ： When the graphics are stitched, it may cause mismatch
phenomenon. This parameter is used to eliminate the misalignment.

Test：Test Rotary Axis.

Figure.8-4 Rotate test

8.2. Rotary Marking2

8.2.1 Interface description

"Rotary Marking" is to perform rotation marking according to the angle of the rotation axis
to process the entire figure.

Click on the "Rotation Angle Marking" menu item under "Laser" to display the following
dialog box:
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:

Figure.8-5 Rotate angle mark

Total Number: The total counts that the marking command should be executed. If
checking the “Continuous”, the marking number will not be limited by the total number;

Axis：Choose which axis to use；

Continuous: If it is checked, it will not be controlled by the total number, and it will
perform continuous marking for graphs or text contents displayed in the workspace.

Mark Selected: If it is checked, only those selected graphs will be marked; otherwise, all
the graphs will be marked;

Input trig marking： Specify an input port and the marking can be triggered through the
IO port.

Overall Marking of Graph: Mark the individual graph or text as a whole at a time, and
after marking an individual graph, rotate for an angle.

Increment: The angle that the column should rotate after mark each figure. It is the angle
interval between two adjacent figures

360 degree mark: Selected to mark the figure on the column evenly

Go to Start Position After Finished: When it is checked, the expansion axis will go
back to the initial position after finishing marking.
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Part: The total counts that the marking command has been executed;

R：Reset the marking status and clear marking count；

Total Time： Total time of marking.

8.2.2 Functional operation

8.2.2.1 Redlight

Click on the "red light " button, you can see the red indicator of the current graphics.

8.2.2.2 Mark

Click "Mark", and the software marks according to the set parameters.

8.2.2.3 Parameters

Click “ Parameters” to configure specific parameters for the rotary marking, and the
following parameter configuration dialog box is displayed. The expansion axes 1, 2, 3, and 4
correspond to the expansion axes 1-4 (Refer to section 8.1 for related parameters.) .

8.2.2.4 ESC

Click "ESE", the system will save the configured parameters for the next use.

Note: If you click the "X" button in the upper right corner of the dialog, the
modified parameters are not saved.

8.3. Expansion Axis Marking

The expansion axis marking function divides the picture into a specified size and then
mark while rotating. The interface is as
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follows:

Figure.8-6 Extend axis mark

Axis ID： Choose Axis 1,2,3,4

Axis Diameter：Diameter of Axis.

Rotating step：The angle or distances each round that the expansion axis rotating.

8.4. Power Ruler

The function of is Power Ruler mainly uses for to design each kind of scale, as is shown
in Figure 8-7:
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Figure.8-7 Power Ruler

File：

New File ：The software will close the documents which you are editing and meanwhile
create a new file
Open File：When click “Open”, the software will pop an open-file dialog to ask you select
the file you want to open
Save File: save the current file to disk.
Save as: save the current file to disk by another name.
Export to WS: export the file to the software workspace.

Marking File：

New ：Create a file that need to mark. Under normal circumstances, a ruler needs to
mark a few figures .

Edit: Revision the content.
Delete：Delete the content.
Click “Add” presenting to edit the ruler, following dialog box shown in Figure 8-8
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Figure.8-8 Power Ruler Tick

Type：
Line： The current parameter is the line parameter value
Value：The current parameter is the value parameter value
Text：The current parameter is the text parameter value
VectorFile：The current parameter is the vectorfile parameter value
Text：
Rotate: the angle of the text revolving

Hatch:

Pen No.：This item indicates that objects with selected pen’s number will be marked.

Graduation Num: The total graduation numbers need to be marked
Start Graduation: Set the position of start marking graduation
Increment pos: the space between two neighboring lines
Line width: Set the width of the line
Start point: Set start point of the line
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End point: Set end point of the line

Start value: Set start value of line

Inc. value: Set Inc. value of the line

Dot bit count：Set dot bit count of the line,

Straight ruler/Ring ruler/Disk ruler: The ruler's type need to mark currently choose is
enable

Part diameter: The workpiece accurately diameter of the “Ring ruler” or “Disk ruler”.

8.5. Rotate Text Mark

Rotate Text Mark is a marking method in which the text is divided by each character
and then the individual characters are marked while being rotated.

As show in figure 8-9：

Figure.8-9 Rotate Text Mark

The configuration parameters are the same as those for the Rotary marking.

8.6. MultiFile Mark

“MultiFileMark” module is able to mark repeatedly different *.orz files, avoiding
changingthe files. That function menu is shown in figure 8-10:

The left text box shows the file name, and the right border shows a preview
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image of the selected file after checking the preview.

Double-click on the file name and open the marking file on the main screen to
edit it.

Figure.8-10 Multifile Mark

8.6.1. File Manage

Add: Add .orz files. The dialog box pops up as Figure 8-38 after click “add” button.
Setting I/O control conditional for files, and automatically mark files when board
accept the IO signal in mark status.

Figure.8-11 File Menu

Gray：Gray means not used
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Blank：Blamk means low level

Black Hook：means high level。

Delete: delete files.

Prev, Next: change the order of files.

Modify: change file selected and IO control conditional

8.6.2. Option

One port trigger：Use a port to mark the preset files in order.

Open：Open saved multi-file marking scheme。

Save：Save the currently designed multi-document marking content as a scheme。

Mark：After clicking , software will enter the state of waiting for the IO signal to
trigger. At this time, the IO signal can be triggered to mark the corresponding
document.

Figure.8-12 Marking Interface

8.7. Mobile Mark

“Mobile mark” module is able to split joint big content. We can either choose an
expansion axis to be X direction split joint, or choose two expansion axes to be XY
direction split joint respectively.

That function menu is shown in figure 8-13-1:
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Figure.8-13-1“Mobile mark”Interface

8.7.1.Mark Parameter

Part: The part count that has been marked. Press the button R on the rightwards will
reset the part count

Total Time：Total time of marking。

Total Number: It means the total number to be marked. When the processing number
meets the requirement, the system will stop marking automatically.

Continues: Repeatedly mark the figure until stop it manually.

Input Trig Marking：Select whether to mark through the input port.

X:/Y:Set which axis X and Y correspond to。

Current Posion：

Length: Displays the maximum movable distance of the platform in the x and y
directions (set by axis parameters);

Starting point: shows the coordinate position when starting marking;

Current point: Displays the current position (distance from the starting point);

Target point: The coordinate position of the target point.
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8.7.2.Platform move

Used to manually adjust the position of the platform.

Absolute distance: After checking, the moving distance is the distance from the starting
point; otherwise it is the relative distance from the previous position;

Return to zero：Moving the platform from its current position to zero (starting point)
can be used on platforms with no physical zeros and physical zeros.

Target location : Move the platform from its current location to the target
location.

Adjust：After the parameters of the extended axis are configured, click the up,
down, left, and right buttons to move the platform up, down, left, and right by the set
distance. The unit is mm.

8.7.3.Marking configuration

8.7.3.1.Configuration

Marking configuration: In the Marking configuration list, select or enter a marking
Configuration name. Click "Configure Plan" to enter the following

picture:

Figure.8-13-2 Configure Scheme

Marking method (marking): It is divided into non-marking and static marking. When
you select static marking, you can set the number of markings. When the number of
markings is greater than 1, marking points are evenly distributed between the previous
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point to the target point';

Marking times: Set the number of markings for this document.。

Target point: The coordinates of the center point of the current marking diagram
(unit: mm);

File name: Click the to select the file, which is the company's software
format (suffix is .orz).

After setting the project entry, click "OK" to make it effective, and "Cancel" to
abandon the modification.

8.7.4.Marking

8.7.4.1. Red Light

Click on the "red light" button to show the outline of the current marked image.
8.7.4.2. Mark

Click on the "Mark" button, then software will mark according to the selected image.

During the marking process,the starting point is the starting point set by the system,

and the target point is the coordinates of the last marking point of the marking program.

8.7.4.3. Extended axis parameters

Refer to the 8.1.1 configuration。
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FIgure.8-13-3 Extended axis parameters

8.8. Split Mark

Due to the limited range of laser marking (usually no more than 15cm), when the customer
needs to carry out a large-scale pattern marking, a large pattern needs to be divided and marked
with a moving platform or a moving laser head.

The menu for the "Split Mark" function is in the "Laser" category.

Before using this function, you must first import or edit the file on the main screen to be
divided. The file can be a picture, a vector, a text, or a self-compilation graphic. It can be a
single figure or a combination figure.

Main interface as following fig：
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Figure. 8-14-1 Split Mark main Interface

"Split Mark" function, object can be divided into multiple pieces designated for

marking.

8.8.1. Marking Parameters

.
Part: The part count that has been marked. Press the button R on the rightwards will
reset the part count.

Total Time：Record the total time for marking。

Total num: The total count need to mark. When the parts have been marked reach
the Total num,software will stop it automatically

Mark Selected: Only those figures selected will be marked.

Continues: Repeatedly mark the figure until stop it manually

ID: The current expansion axis will be used as axis X/Y

Input port trig: Select whether to mark through the input port, select the specific port
on the right.

Zero: After processing a workpiece, the system will move expansion axis back. 。

Motion Split：

Area size: The size of the area where the largest frame of the graphic needs to be
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marked;

Fixed Split: When this option is selected, the pattern is divided into specified size; if
not, the average size is divided according to the size of the pattern.

Equal-Split: Indicates the number of pieces to be divided. Filling "1" indicates that
the direction is not divided.

The setting of the extension axis movement error (gap compensation and
offset compensation) in split marking:

Offset compensation: Platform integrity compensation, which can be a negative
value. When the movement actual value is greater than the target value, it is set as a
negative number, otherwise it is a positive number.

Gap compensation: Displacement between patterns is adjusted using this parameter,
and the value is measured by the actual size (this size is the error size between the
second and first patch images in the same direction);

8.8.2 Pattern display area

This area shows the size of the mobile platform (displayed by the black

coordinates), and the size of the pattern (shown by the blue rectangle). Blocks

of the pattern indicate the mode of split marking. The red dot indicates the

initial marking point, the blue dot indicates the target marking point, and the

green dot indicates the path point.

8.8.3 Movement

Control to move up, down, left, and right.

Emergency stop: Stop the movement of the mobile platform immediately

8.8.4 Marking Function

Red light: Preview the current marked image outline.

Marking: Dividing mark according to the selected marking scheme.

Axis parameters: Same as 8.1.1.
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9. Marking
Including single-card marking and multi-card marking。

9.1. Single-card marking

The Marking Properties Toolbar is as shown in Fig. 9-1.

Figure.9-1 Marking tool bar
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9.1.1 Pen List

Each file in SeaCAD has 256 pens which correspond to the uppermost 256 pens in

Marking Properties Toolbar with pen numbers ranging from 0 to 255.

indicates that the current object to be marked

corresponding to the current pen number requires marking. Users may change it by

double-clicking this icon.

indicates that the current object to be marked

corresponding to the current pen number requires no marking.

Color: The current pen’s color, which will be displayed when the object is corresponding

to the current pen number. Users may customize the color by double-clicking the color

sticker.

Apply Parameter Button: When users press this button, the pen number of the current

object will be changed to the one that the color stands for, as shown in Fig. 9-2.

Figure.9-2 Apply Parameter Button

When the user right-clicks on the current list, the right-click menu as shown in Figure 10-3

will pop up.

图9-3 右键菜单

Here we will introduce the specific meaning of each parameter in Fig. 9-1 in details.

Current Pen Number: The set of marking parameters currently used. In SeaCAD, the

concept of “pen” is equivalent to a set of given marking parameters.

Marking Quantity: The marking times for each object during one marking are equivalent
to the marking quantity in its marking parameters.
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Speed: The marking speed of current marking parameters.

Power: This item indicates the power percentage of the current marking parameter, and

100% refers to the maximum power of current laser.

Frequency: The laser’s frequency in the current marking parameter.

Duty Ratio: The ratio of laser pulse duration to pulse period.

Start TC: Delay time for laser ON at the beginning of marking. The proper Start TC

parameters set can eliminate the “match head” appears at the beginning of marking,

while the too large ones may cause miss at the initial segment. This value may be

negative, which indicates that the laser emits light in advance.

Laser Off TC: Delay time for laser OFF at the end of marking. The proper Laser Off TC

parameters set can eliminate the misclosure phenomenon appears at the end of marking,

while the too large ones may cause “watch head” appears at the termination segment.

This value cannot be negative.

End TC: Generally, there is a period of response time from sending laser OFF command

to completely laser OFF, proper End TC is set to provide the laser with sufficient

response time for laser OFF, so as to make the laser perform next marking in case of

totally OFF to prevent light leakage and point dragging.

Polygon TC: Delay time between each segment during the marking. The proper Polygon
TC parameters set can eliminate the circular angle appears during right angle marking,

while the too large ones may cause marking time increase and double points at the

corner.

Clicking “Advanced…” will prompt an advanced parameter dialog box as shown in Figure

8-4.

9.1.2. Equipment Parameter

9.1.2.1.Field Parameter

See Fig. 9-4 for the field parameter of equipment:
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Figure.9-4 Field Parameter

Field Size: The actual widest range for marking corresponded by the scanhead.。

Offset X: The offset distance of scanhead center in X direction from field lens center.

Offset Y: The offset distance of scanhead center in Y direction from field lens center.

Angle: Adjust the angle of the galvanometer.

Maximum line length: The maximum length of the line segment that is divided by the figure. It
is used to split the line segment beforehand to deliver the data, so as to improve the marking

Software User manual EN 143



accuracy.

Use the Calibration File: Use the calibration file generated by external calibration
program to calibrate the scanhead.

XYChange: Change the axes corresponding to the original galvanometer signal 1 and signal 2.

Negate: The opposite direction of the current scanhead.

indicates the barrel distortion or pincushion distortion calibration coefficient with
default of 1.0 (parameter range: 0.875-1.125).

indicates the parallelogram calibration coefficient with default of 1.0 (parameter
range: 0.875-1.125).

indicates the trapezium calibration ， with default of 1.0 (parameter range:
0.875-1.125).

Scale: It refers to the flex percentage, and the default is 100%. This parameter will be
adjusted when the trim size marked is different from the setting size. If the trim size is
smaller than the designed one, users can raise this parameter; if the trim size is bigger
than the designed one, users can lower this parameter.

Note: If there are some distortions with the laser scanhead, users must firstly adjust the
distortions and then the flex percentage.

During scale setting, we may press the button directly, and a dialog box like Fig. 9-5
will be popped up. After we input the set size in software and the actual marking size
measured, the software will automatically calculate the flex percentage.

FIgure.9-5 Calculate scale

Go to Specified Position after Marking: After the completion of current marking, move
the scanhead to its specified position.

Password: Set the current parameters can only be changed by entering the password。
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9.1.2.2.Laser Parameter

See Fig. 9-6 for the laser parameter of equipment:

Figure.9-6 Laser Control

Please carry out the adjustment as per the actual parameters of laser machine.
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9.1.2.3.Port Parameter

See Fig. 9-7 for the equipment port parameter.

Figure.9-7 Port

Input Port of Stopping Marking: Certain input port is specified as marking stopping port.
During marking process, if the system detects there is a corresponding input signal, the

current marking operation will be ended, and prompt the users with error information.
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Gate Port: Check the port signals for safety gate opening and closing and make sure the
marking will automatically stop in case of safety gate opening (red light indication may

continue being used) so as to protect the operators from being burnt.

Laser Power Supply Output Port: This port may be used to control the on-off of laser

power supply.

Red Light Pointer Output Port: The system will output high level to the appointed

output port during red light pointer.

Mark Output Port: The system will output high level to the appointed output port during

marking.

Mark Starting Port: In idle state, the system will start marking automatically if high level

is output by the appointed input port.

Start Signal Pulse Mode: Checking this option means the start signal is marked by

software in pulse mode, even for continuous level input, the software only reads one

pulse. Otherwise the input port marked is of continuous level.
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9.1.2.4. Advance Parameter

Figure.9-8 Advance Parameter

Jump Speed: Set a jump speed corresponded by the current parameter.

Jump Position TC: Value of Jump Position TC.

Jump Distance TC: Value of Jump Distance TC.

After each jump movement, the system will delay some time, and then execute the next
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command. The actual delay time is calculated by the following formula:

Jump TC = Jump Position TC + Jump Distance × Jump Distance TC

End Point Compensation: This parameter requires being set only when the end point
fails to be put in place by TC parameter adjustment during high-speed marking, by
means of proceeding to marking a straight line with length of end point compensation
distance at the end of marking compulsively. Negative value is supported.

Acceleration Distance: This parameter may be set properly to eliminate the uneven
dotting at initial marking segment.

Dotting Time: It indicates light emitting time of each point in case that point objects exist.

Vector Dotting Mode: It indicates to compulsively specify the fixed pulse number given
out by the laser during each point marking.

Add Point at the End: It is used to solve the problem of laser end shining. The software
will automatically add points at the end of each pen, but will not display it as an object.

Quantity: Quantity of points added at the end.

Distance: Distance between the points added at the end.

Dotting Time: Marking time for each point added at the end.

Dotting Times: Marking times for each point added at the end.

9.1.2.5. Fly Mark

Mark it synchronously with the production line. Click the button “Mark on the Fly”, a dialog

box as shown in Fig. 9-9 will be popped up.
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Figure.9-9 Fly Mark

Fly Mark: If it’s checked, the function “Mark on the Fly” can be used.

Right-to-left Line Direction: If it’s checked, the software will consider the line direction

being right-to-left. By default, the line direction is left-to-right.

Rising Edge (High Level) Trigger: It indicates that marking will be executed when a

rising edge signal is received from the input port (In8 or In9).
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Continuous Line Mode: If it’s checked, cable marking mode will be started and “Initial

Movement Distance” and “Marking Spacing” parameters may be set.

Enable Hardware Simulation Fly: In case that the photoelectric encoder is not

connected to detect fly speed, the hardware simulation fly shall be checked and its speed

coefficient shall be set.

Enabling long marking: For marking the object beyond the size range of the galvanometer, you

need to check and enable the long marking, and fill in the size according to your needs. The

system will divide the marking object according to the fill size.

Marking through characters ： When marking, the pipeline moves from left to right. The

characters of the marked file are marked from right to left.

Fly Speed System: It is used to set the line operation speed.

Mark on the Fly: If it’s checked, the function “Mark on the Fly” can be used.

Right-to-left Line Direction: If it’s checked, the software will consider the line direction

being right-to-left. By default, the line direction is left-to-right.

Rising Edge (High Level) Trigger: It indicates that marking will be executed when a

rising edge signal is received from the input port (In8 or In9).

Continuous Line Mode: If it’s checked, cable marking mode will be started and “Initial

Movement Distance” and “Marking Spacing” parameters may be set.

Enable Hardware Simulation Fly: In case that the photoelectric encoder is not

connected to detect fly speed, the hardware simulation fly shall be checked and its speed

coefficient shall be set.

Fly Speed System: It is used to set the line operation speed.

Operation steps:

1. Start line movement and label the current position;

2. Stop the movement after a period of line movement;

3. Measure the distance and input it in the edit box “Operation Distance”, click

“Calculation” and obtain the corresponding operation speed.

4. Save and exit.
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9.1.2.6. Red Light

Figure.9-10 Red Light

Red light style: Used to select the red light to display the bounding rectangle of the

figure or the outline of the figure.

Red Light Speed: It indicates the system movement speed in case of red light pointer.
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Offset Position: It indicates the system movement offset position in case of red light

pointer and may be used to compensate the position error between red light and actual

laser.

Size Scale: It refers to the size deviation between red light and laser, by adjusting which
the two can completely coincide.

9.1.2.7. Others
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Figure.9-11 Others

Delay for Starting Marking: Start the marking after delay of appointed time at the

beginning of each marking.

Delay for Finishing Marking: Finish the marking after delay of appointed time at the end
of each marking.

Max. Power Delay: After the marking power changes from 0% to 100% during the

system operation process, the system will delay this value and perform the next marking

action. If the power’s range changes by less than 100%, the system will automatically

decrease the delay value in proportion. Similar to the “Delay for Starting Marking”, both

these two parameters are used to adapt the response speed of laser power supply. If the

laser supply has quick enough response time, this value may be 0.

Max. Frequency Delay: Similar to the “Max. Power Delay”, it is used to adapt the

response speed of the laser’s Q actuator. If the Q driving power supply has quick enough

response time, this value may be 0.

Automatic Reset Marking Quantity: When the parts number reaches the total marking

number designated, the parts number will be reset automatically.

Forbid Marking after Designated Marking Number is Achieved: When the parts

number reaches the total marking number designated, the system will pop up a dialog

box to prompt that “the current number has exceeded the total marking number, please

reset it, and then start marking”.

Display the Dialog Box for Starting Marking: After checking, it will prompt a dialog box
of “whether to start marking” for each time selecting marking, as shown in Fig. 9-11.

Figure.9-12 Start Marking Dialog

Enable to Execute Mark Start and Stop Command File: A command file needs to be
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executed first at the beginning and end of marking.

After enabling this function, when the marking starts, the system will seek for the start.bat

file under the current software of contents automatically and execute it; after the marking

has ended, the system will seek for the stop.bat file under the current software of

contents automatically and execute it.

The bat file, with simple format, may be compiled with text editing software (such as

notepad and tablet) directly. Bat is the pure ascii code text file, altogether has 3

commands.

1. Input port detection. For example, IN2 = 1 indicates the input port 2 is detected. If IN2

is high, continue detection to the smaller number; otherwise wait for IN2 to turn high.

2. Output port setting. For example, OUT4 = 1 indicates the output port 4 is set as high

level.

3. Delay. For example, DELAY = 1000 indicates the system is 1000 ms delayed.

Enable Offline Marking: The same data once marked may be marked off-line.

Enable Step Mark Mode: It refers to move as per the min. scanhead movement step

during the marking and delay the fixed time after one step is completed. This function is

mainly used for high-power laser marking. The longer delay between steps indicates a

deep marking at the position where laser stays.

Enable to Restrain Simulation Current: Restrain the simulation current at the

beginning of marking and make the time be 0.

9.1.3.Mark

The Marking dialog box is at the bottom right of the SeaCAD interface, as shown in

Figure 9-13.
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Figure.9-13 Marking Dialog

Red Light: This item is used to mark the frame of the object without laser output and

indicate the marking area so that users are convenient to orient the workpiece. This

function is available in those laser machines which have red guide light. Key “F1” is the

shortcut key of this function.

Mark: To execute marking. Key “F2” is the shortcut key of this function.

Continuous: Mark the current object repeatedly without stop.

Mark Selected: Only those selected objects would be marked.

Part: It indicates the total quantity of parts which have been marked.

Enable display outline: Check this function to display the outline of the figure when

displaying red light.

Total Number: It indicates the total parts to be marked, which is ineffective under the

mode of Continuous Marking. If the total part number is more than 1, the marking

operation will not stop until the number of parts marked is equal to the total part number.

R: Marking parts reset.

Parameter: It is used for equipment setting.

Enable Continuous Red Light Marking Mode: After selecting this function, returning to
the software interface and clicking “Marking”, a dialog box as shown in Fig. 9-14 will

appear. It will appear after each marking and red light preview will always exist.

Figure.9-14 Continuous Red Light Marking Mode
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9.2. Multi-Card Mark

Open multiple documents and mark different document content on multiple

different/same type lasers.

The following figure shows the Multi-Card Marking Control Bar.

Figure.9-14 Multi-Card Marking Control Bar

9.2.1 Multi-parameter management
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Figure.9-15 Multi-parameter management

Under normal circumstances, edit the default parameters and set them according to

the current corresponding laser. Then you can create new parameters or edit the default

parameters.

9.2.2 Device Association Management

Figure.9-16 Device Association Management

Configure Parameters for Device;Associate document with devices.

After all devices are associated, you can choose to save the associated configuration. In
this way, the next time you need to do the same processing, you can directly open the
associated plan without having to re-set it.

9.2.3 Mark

Click Marking, the following interface appears, showing the marking

status.
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Figure.9-17 Multi-Device Mark
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10.Scanhead Calibration
10.1.Direction adjustment

The direction needs to be adjusted to the same direction as the drawing area before the
calibration.

For example, draw a text in the drawing area, as shown

below:

Try to change the three checkmarks in the blue box below and mark until the marked
figure matches the drawing area

.
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10.2. Manual correction

Manual correction, enter from the right parameter (F3), as shown in the blue box in the

figure below. By default, the galvanometer 1 corresponds to x and the galvo mirror 2

corresponds to y. If the xy swap is checked, the galvanometer 1 corresponds to y. Galvo

2 corresponds to
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x:

10.2.1.Shape adjustment

Adjust the curvature, trapezoidal deformation, parallelogram deformation.

Each time you change the curvature, trapezoid, and parallelogram parameters, click
"Mark test rectangle" until it is square.

10.2.2.Zoom

According to the marked figure, measure the actual size,Zoom in/out, as shown
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below:

In the first step, click on the “marking X scale line” and the software mark a line in X
direction.

10.2.3.Save

Click "Save" to save the parameters using the current file name (or default file name);

click "Save Data As" to save the file using another file name.

The saved file can be used for data correction of the marking software.

10.3. Fitting correction

For applications where the accuracy requirements are high.

Correction related parameter settings

1. On the right side of the main interface, select in the marking parameter field to open

the parameter setting. The shortcut key is F3.

2.Determine the scope of the field lens. Take 120mm as an example, change the area

size parameter to 120.

3. Set the galvanometer direction, as shown below;
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Figure9-1 Field Parameter

10.3.1 Start correction

From the menu, enter Fit Correction to enter the Fit Correction operation interface.
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10.3.2Marking correction graphics

Set the verification area to 100mm, set the verification points, and reset.

Click on the “Marking Verification Graph” to mark the following graph (x and y are used to

illustrate the orientation of the graph and will not be actually marked). Note that the

direction and position of the short segment and the upper left triangle must follow the

figure below.If not, adjust the XY swap, X reverse, and Y reverse parameters of the main

interface until the marked figure is in the same direction as the figure above.
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When measuring the coordinates of a point, minimize the measurement error.
Measure the coordinate values of the 9 points in the above figure in sequence, based on
the center point (point 5). The sequence number is as shown in the following figure:
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 Measure the coordinate values of 9 points in sequence using the center line of the cross

(the line of the straight line passing through the No. 5 point) as a reference and record it.

The measuring method is that the vernier caliper coincides with the X-axis or Y-axis of the

cross centerline, and the other side coincides with the point to be measured, and the

reading is the correction value at this time. Or use a quadratic element measurement.

Take the first point correction value as shown in Figure 9-5 as an example: (It can be

considered that the method of measuring the average value of 3 times will be more

accurate)

 Fill the measured values in columns 4 and 5 of the data sheet. Among them, the 2nd and

3rd columns are the set distances, and the 4th and 5th columns correspond to the actual

marking distances. Note that the measured values are positive and negative.
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 Click "Save" to save the file (here saved as 9dot.cor) as shown in Figure 9-9；

Figure.9-9 Save calibration file

After saving, you can click “Marking Verification Pattern” to mark, as shown

below:
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10.3.3Use calibration files

The coefficient file saved may be used for marking calibration in the setting interface

below.

Use Calibration File

10.3.4 High-precision correction

After the above-mentioned fitting and correction, generally speaking, the accuracy

can meet the requirements. If the uniformity can not meet the requirements, the equal

division correction can be added in the x and y directions.

Check the "Dividing ratio method" and the following interface appears:
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10.3.4.1 Set X Proportional Parameters

In the first step, click on “Mark X Proportion Lines” and the program marks many

lines that change from shorter to longer along the x-axis.The second step, click "Set X

Proportional Parameters" to enter the proportional value setting interface。
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Measure the distance (mm) between the short line and the center line in the order

described in the figure, fill in the right table, and click OK to return to the main screen.

In the third step, click “Marking x Test Line” and the software marks a series of short

and long lengths along the x-axis. (The size of the verification area is divided into 20

equal parts. For example, the verification area is 100 mm. The standard distance

between adjacent bisectors is 5mm), measuring the distance between each short-line

and the centerline. If an interval is greater than the standard equidistance, you need to

increase the distance of the proportional parameter. If it is less than the standard

equidistance, you need to reduce the proportional parameter.

For example, if the distance between line 5 and line 6 in the graph is 4.9, assuming

that 6, 7, 8, 9, and 10 are correct, then the distance between line 5 and the centerline is

29.9. According to the data entered in Figure 2-13, this value is between "6" and "7".

According to the above rules, we need to adjust the data in point "6". Since 4.9 is less

than 5, we need to reduce the original value of 30.8.
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10.3.4.2 Set Y Proportional Parameters

The operation steps are the same as those in 10.3.4.1。

10.3.4.3 High precision correction

For high-precision requirements, you can use the equal-division ratio adjustment in

the X and Y directions to achieve high accuracy.

The following example illustrates the adjustment operation. Assuming that the

scanning scope of the galvanometer is 120X120mm, the verification area is 100X100mm,

and the required accuracy is 0.05mm.

Firstly, use nine-point correction to correct the deformation; select the equal-division

ratio method to mark the X- and Y-axis bisectors, respectively, and divide them by 5mm

into equal parts. In the full-width X- and Y-axis directions, they are 25 lines. measure the

distance between each line to its centerline, the left/lower end is negative and right/top is

positive, and the measured values are entered in the scale parameter table. These

measurements are mostly the basis for adjustment. On this basis, start the adjustment.

1.Mark a 100*100mm rectangle and measure the length of the top, bottom, left, and

right sides;

2.If the difference between the actual measured length and the 100mm is greater

than 0.05mm, adjust the 50mm or/and -50mm corresponding value in the X or / and Y

proportional parameter table according to the actual measured value, and increase or

decrease the value and save it. Mark the rectangular frame again, measure the lengths of

the four sides of the rectangle, see the influence on the size of the rectangle, and record

the values before and after the adjustment and the corresponding measurement values

of the rectangular frame; it can be inferred that the influence of X/Y on the size. If it is

satisfied, it ends; otherwise, steps 1 and 2 are repeated until the accuracy is satisfied.

3.If you also need to adjust the accuracy of the 90*90mm rectangular box, you can
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mark the 90*90MM rectangular box, adjust the corresponding measurement value of

45/-45mm, do the same operation in steps 1 and 2.

10.4. Grid correction

To be perfect
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11. Help

11.1. About SEACAD

Click "About SEACAD" to display the software version information.

11.2. Software registration

Please ask the control card supplier for the registration code and fill in the

“enter registration code” column to complete the software registration.

11.3. Help documentation

Click "Help Documentation" to open the software manual directly.
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Operating Manual

1. Push out the scan head of laser machine

Loose the four screws, then push out the scan head,
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2. Adjust the position between turning table and laser

machine

Adjust the two device position to be a suitable position relatively.

Connect the table cables on laser machine.
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Put the ear tags with tray on the working table, then use the steel

ruler to adjust the focal length.
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Then input the marking content in the Ezcad software, use the

“Red(F1)” to adjust the laser machine position to be suitable to one

working bench on the turning table.
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3. Fix the two device

Loose the four feet of the two device to fix the two device.
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4. Start marking / stop marking

Press the “start” to start marking job on ear tags, or click

“Mark(F2)” button to start marking job.

Press the “Stop” button to stop marking.

“Turn table speed controller” can adjust the turning table speed.

Turning clockwise to increase the speed of turning table; Turning

anticlockwise to reduce the speed of turning table; the switch on the

“Turn table speed controller” can cut the power of turning table.
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